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Introduction

What is Moodle?

Moodle is a CM.S. (Content Management System) with OpenSource license dedicated exclusively to online
learning, better known as e-learning.

Moodle in a more specific way is called LM.S. (Learning Management System), a system for managing online
courses designed to create virtual classes that allow distance learning and training experiences (FAD)

Why Moodle

The main feature of Moodle is to rely on very solid pedagogical principles, which responds to
the principles of constructive teaching based on confrontation and negotiation, an active
approach to the construction of knowledge.

Definition of Moodle course

The term "Course” refers to the virtual space dedicated to the loading and management of teaching material
for each individual teaching.

In the TRAPP Project e-learning platform the courses are set according to the format by topics, which allows
to subdivide the material organizing it according to the themes chosen by the teacher.
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Roles

A role is a set of privileges defined at the site level. The role can be assigned to users in specific contexts
(category of courses, individual courses, activities, etc.). This means, for example, that a user can have the role of
Student within a course, but more privileges in another course or within a specific discussion forum.

Starting from the predefined ones, customized roles can be created for specific needs (monitoring, evaluation,
etc.)

ROLE DESCRIPTION |

SITE ADMINISTRATOR Can "do everything” on the site

MANAGER Managers can access and modify courses but generally do not participate in
them

COURSE CREATOR Can create courses

TEACHER Can manage and add content to courses

TEACHER NON EDITOR Non-editor teachers can teach in courses and evaluate students, but they can
not change activities

STUDENT Students within a course usually have limited privileges and can only use the
resources / activities made available by the teacher

GUEST Guests have minimum privileges and can not normally participate in activities

AUTENTICATED USER The role all logged in users have
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How to connect

Methods to access the "TRAPP Project" e-learning

First of all, the administration of the platform must register and send you the login credentials (username and
passwora).
To connect to the project's e-learning platform, simply type the URL in any web browser.

e B hitpsTesenng ewrcpeantegiterphiebologists.eu * @ G | trpp project phiebologists =) -7 p x
9 Links Menu Q@engisn(en) [ TEEEOSND PR ool Type the URL:
QAo
https://learning.europeanregisterphlebologists.eu/
Welcome to European Register of Phlebologists e-learning website n in the brOWSGrIS addreSS bar' ClICk on the Log In bUtton
1 ® REGISTERT

File Modifica Visualizza

VET CURRIGULUM FOR PHLES . |l i Type the URL'

€ c e

https://europeanregisterphlebologists.eu/

TRAINING
- in the browser's address bar and click on the entry of
Sliskhiets "Training" menu

FOLLOW:
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How to login

Access the portal as a teacher

2 i & = NG —ﬁ*" First of all, the administrator of
9, Links Menu e 1§ the platform must register and
Qe o send you the access credentials
: (username and password).

To log in, you must enter your
data in the Login block at the top
right.

Logout procedure

To log out, always click on the
(Exit) link next to your name and
surname; avoid closing the browser
window without first logging out.

INFO FOR TEACHERS INFO FOR STUDENTS ' Course list

This manual is intended to be a

HOW TO REGISTER FOR A COURSE List of all the cours h you List of all the courses ta which you
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The Teacher's home

Blocks of the teacher's main page

A ® Qenglish(en) () DocenteTest «

QrOo

# Home & Dashboard 63 Events B My Courses Customise thispage FH Hide blocks  Standard view

ULl el R Welcome 16 European Register of Phlebologists e-leaining website n

Course overview

# Site home

¥ Site pages
~ My courses

b PHLEBOLOGY COURSE

D Private files

No files available

PHLEBOLOGY TRAINING COURSE

Manage private files

Phlebology is the branch of medicine which studies and treat venous disease. Despite the AR

extremely large number of patients affected by 4 Calendar
- January 2019 [
oo Twm wed T i me e |
L [ ] 3 4
T & ? 10 "
PO T T )
n @ o o om
m @ w

COURSES LIST 3 Upcoming events

There are no UpComang events

Go to calendar,

& Online users

1 onlne user (last 5 minutes)
Docente Test
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Header and Functionalities

Change the characteristics of your profile

Qg Links Menu A = Q@ English (en) ente Test ~

EDIT PROFILE @ Dashboard
& View profile

£3 Edit profile

GRADER
= » Preferences = Grades < — F;(gFF;GRT
Preferences CONFIGURE ALL PREFERENCE £¥ Preferences STUDENTS

B9 Calendar
= Log out

User account
# Home

= Edit prafile

s Change

Register an external blog

& English (en) . Docente Test ~

CHANGE THE LANGUAGE English (en)

& Editor preferences
= Course preferences

idar pr

Italiano (it)
Portugués - Portugal (pt)
Roména (ro)

ExAnvika (el)
@ Dashboard £ Events &= My Courses _—

S Links Menu A4 = @ English (en) . Docente Test ~

Messages New message & L

Notifications

J o
You have no notifications
COURSE LIST

l Notifications setting

No messages

Messages setting

# Home & Dashboard B3 Events

PHLEBOLOGY COURSE
ANNOUNCEMENTS Go to European Regi B n
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Header and Functionalities

Evaluation management

G, Links Menu

A = & English (en)

& Dashboard

. Docente Test ~

PHLEBOLOGY TRAINING COURSE gEEst

@& Dashboard ®3 Events -

= > Grades

Courses | am teaching

Course name

PHLEBOLOGY TRAINING COURSE

Go to individual board
of course in list

£ Edit profile

= Grades

& Preferences

B Calendar

& Switch role to_.

= Log out

My Courses &h This course

" ® Tum editing

« Navigation

Dashboard

# Site home
P Site pages
* My courses
* PHLEBOLOGY COURSE
b Participants
b 4 Badges

a Competencies

I rades

Crecrall average

¢ General
GICAL
Grader report
L OGY
Grader report Grade history Outcomes report Overview repoat Sangle view User repot
_ N MAGING
All participants: 1/1
Firsirame M » e c o € Flg JKLMHNOP GRS TUWWXY Z HERAPY
Swnome [EIMM A s cpEFlesH I JKkLMNOPORS Tuviwxyz .
MENTS IN
PHLEBOLOGY TRAINING CO_ =)
Surname = First name Email address Country @ Test lesson 1 = #° (@ PRINCIPLES OF HAEMODI.. = # (@ VENOUS INSUFFICIENCY = #° @ [Deletion in progress] VAS. = #° (@ [Debetion in progress] LYM
Studente Test @+ tecnico@econetit IT -Q B! “Q
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Administration block

28 Administration

Edit course settings

» Expand all
~ General
* Course administration
Course full name « PHLEBOLOGY TRAINING COURSE
¥+ Edit settings
/’ Turn editing off Course short name =« () PHLEBOLOGY COURSE U@ in Dlape of tlﬂﬁ in emL |
EDIT COURSE headers o breaderumbs
#* Course completion Course category Phlebology i - . ]
w Users . | Determir lﬁ,"m, ility of the caurse,
Course visibility ) Show|v| | Teachers will still be able to access
2. Enrolled users - them
» Enrolment methods Course start date () 19[%| December [»w]| 2018~ o00~] 00w )
2 Groups Course end date 31[>]  December %]  2013[>]  o00[v]  00[%] By &2 Enable
» Permissions 1
CouseDmmmber @ |4 Onnmal.ldmuﬁemoodsuaadw
L. Other users ‘ E stﬁ@- Does not.
T Filters » Description
w Reports
+ » Course format
] Competency breakdown
£l Logs » Appearance
] Live logs .
» Files and uploads
(| Activity report
fd course participation » Completion tracking
(ol Activity completion
» Groups
#* Gradebook setup
& Outcomes » Role renaming &
¢ Badges i
» Tags
& Backup 9 Save/lUnde Changes
¥ Restore : Y]
& import Confiauration canc
< st Sections
¢ Question bank There are required fields in this form marked »

2= Repositories
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Edit course settings

Description
» General

~ Description

Course summary (7)

= al BB

phlebology as an academic specialization has never been astablished.
For many years phlebology has been practiced by general surgeons, vascular surgeons,
- - intermal medicine doctors, dermatologist and many other different professional medical
mw|m figures. Recently in many countries also radiologists, assthetic doctors and many other
tﬁt“m kind of doctors (sven dentists) are practicing phlsbology.
A many other field of medicine, phlebology has dramatically changed as recantly now
- advanced treatment have been introduced.
These advanced treatments require special skills and knowledge that can be achieved
only after a specific training and special interest in this field.
For those doctors practicing phlebology as a minor part of their practice advanced o
treatmeants are not available as they neaed knowledge and special skills not always part of
Path: p

paragriph  ~ | B [ | i= |

~

C ses files & Maximum size for new files: 16MB, maximum attachments: 1
&,

oo
—_ oo

» (& Files

 PowerPoint )

corsod_jpg

Accepted file types:

Image (GIF) gif
Image (JPEG) jpg
Image (PNG) png

PDF document pdf

» Course format

» Appearance
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Edit course settings

Course Format, Appearance, Files and uploads

» General

- The format sels the course display:
= Single activity format-a single resource or
inti activity will be displayed in the course;
3 f ; !
Description - Belational format-A forum will be displayed:
- Format fer topics-the course will be divided
into one section for each topic;

~ Course format - Weekly format-The course will be divided into

Single activity format one section for each week.
Social format \

Format () JEISER{nEL
Weekly format : :
Determines how to display
Hidden sections @ Hidden sections are shown in collapsed form “— hidden sections to S‘,:UdentS:

; ! o = In compact format;

Hidden sections are completely invisible .
= Hidden &ltogether. )
Course layout () B
Show one section per page

Do not force

~ Appearance

English (en) ' i

Italiano (it) Farcing the
Force language Do not force Portugués - Portugal (pt) Iangyagﬁ_ of the

Romana (ro) course site

EAAnvika (el) :

Number of announcements (Z) 5

mssessed.

Some of the activities of a course can be ‘
"Na prevents students from displaying.

Show gradebook to students (7) \"es . %

Show activi rt No | v i
activity reports (3 ¢ reports of the activities performed and

- the logon log.

This setting determines the maximum size of the
Site upload limit (16M B} files you can upload. The selling affects only the

loadable files in the course scope.

Determines whether a student can view ‘

~ Files and uploads

Maximum upload size (7)

TRAPP PROJECT | INTELLECTUAL OUTPUT 3 | Quick guide to using Moodle for teacher’s
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Course Management page

PHLEBOLOGY TRAIN

A ™ G English (en)

To modify the course:

- Modily the sections;
- Madify the contents;
- Change activities.

@ Dashboard B Events il My Courses & This course

. Docente Test ~

=

> My courses > PHLEBOLOGY COURSE

Your progress

Phlebology is the branch of medicine which studies and treat venous disease. Despite the extremely large number of
patients affected by venous diseases (it is estimated that more than 50% than adult population in western countries are
affected by a venous problem), phlebology as an academic specialization has never been established.

For many years phlebology has been practiced by general surgeons, vascular surgeons, internal medicine doctors,
dermatologist and manmy other different professional medical figures. Recently in many countries also radiolegists, aesthetic
doctors and many other kind of doctors {even dentists) are practicing phlebology.

A many other field of medicine, phlebology has dramatically changed as recently new advanced treatment have been
introduced.

These advanced treatments require special skills and knowledge that can be achieved only after a specific training and
special interest in this field.

For those doctors practicing phlebology as a minor part of their practice advanced treatments are not available as they need
knowledge and special skills not always part of their training.

As result of this situation medical care in phlebology is often offered to European patient in an old and more invasive
manner, with higher cost and poor quality of life.

The need for an "European professional phlebologist” is then felt by those who are practicing phlebology as the main field of
their practice. Moreover, even patient's organization are asking the same advancement to the medical world

The Eurcpean professional phlebologist would be the answer to those requests, a professional medical operator that would
be able to deliver professional, up to date, less invasive and cheaper treatments to patients with a venous disease

The TRAPP project wants to describe the path for evaluation and formation of the medical doctor leading to the definition of
the skills and the knowledge of the European professional phlebologist. Moreowver, we believe that the creation of an
European Register of Phlebologist would also be able to contrel and rule this process in different European countries.

@ Announcements
& FORUM PHLEBOLOGY CO O

AMNATOMY —
PRINCIPLES OF HAEMODINAMICS O
est lesson 1

& TestLINK o
(® Test BooK a

VEMNOUS INSUFFIGIENCY
WASCULAR ANOMALIES —

LYMPHATIC PATHOLOGY
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. Mavigation

Dashboard

-

»

Site home

Site pages

My courses

* PHLEBOLOGY COURSE

v

.

=

v

4

v

v

FParficipants

Badges

Competencies

Grades

General

A. BASIC PHLEBOLOGICAL
SCIENCE

B. VENOUS PATHOLOGY
C. NON INVASIVE IMAGING
D. SCLERO

HERAPY

E. COMPRESSION THERAPY
F. SURGICAL TREATMENTS
N PHLEBEOLOGY

THERMAL ABLATION

H. GLUE OBLITERATION IN

VENOUS INSUFFICIENCY
INVASIVE TREATMENTS
FOR VENOUS STENOSIS OR

THROM....

J. TREATMENT

ULCER

OF VENOUS

K. TREATMENT OF

LY MPHOEDEMA

L. DRUG TREATMENTS IN
PHLEBOLOGY

M. MISCELLANEOUS

Course Navigation
block

Course Administration

block

8 Administration

- Course administration

¥ Edit settings

# Turn editing on
¥ Course completion
¢ Users

T Filters

» Reports

¥* Gradebook setup
& Outcomes
Badges

Backup

Restore

Import

Reset

Question bank

Repositories

using Moodle for teacher’s
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Editing a course

PHLEBOLOGY TRAINGSSr e Qe

- Modify the sections;

- Modify the contents; " ® Turn editing off |

- Change activities. /

B Events o My Courses &b This course Hide blocks ™ Full screen

A ™ G English (en) @ Docente Test ~

= > My courses > PHLEBOLOGY COURSE

5 Mavigation

¥+ Configure Navigation block

Phlebolagy is the brach of medicine which studies and treat venous disease. Despite the extremely large & Edit section |
patients affected by vepous diseases (it is estimated that more than 50% than adult population in westenn

affected by a venous préblem), phlebology as an academic specialization has never been established.

For many years phlebology has been practiced by general surgeons, vascular surgeons, internal medicine doctors, # Site home
dermatologist and many other different professional medical figures. Recently in many countries also radiologists, aesthetic
doctors and many other kind of doctors (even dentists) are practicing phlebology.

A many other field of medicini, phlebology has dramatically changed as recently new advanced treatment have been ;
introduced. + My courses

These advanced treatments reqtire special skills and knowledge that can be achieved only after a specific training and

special interest in this field. ¥ PHLEBOLOGY COURSE

Dashboard

v

Site pages

For those doctors practicing phleb&logy as a minor part of their practice advanced treatments are not available as they need » Participants
knowledge and special skills not always part of their training.
As result of this situation medical caré in phlebology is often offered to European patient in an old and more invasive ¥ Badges

manner, with higher cost and poor quality of life. N
The need for an “European professional ghlebologist” is then felt by those who are practicing phlebology as the main field of =
their practice. Moreover, even patient's organization are asking the same advancement to the medical world. -
The European professional phlebologist wold be the answer to those requests, a professional medical operator that would —
be able to deliver professional, up to date, less invasive and cheaper treatments to patients with a venous disease.

Competencies

Grades

s : - » General
The TRAPP project wants to describe the pathifor evaluation and formation of the medical doctor leading to the definition of eness
the skills and the knowledge of the European prafessional phlebologist. Moreover, we believe that the creation of an A. BASIC PHLEBOLOGICAL
European Register of Phlebologist would also be'gble to control and rule this process in different European countries. > S ——
SCIENCE

Edit/delete/Hid

@ @ Announcements X i e task or » B.VENOUS PATHOLOGY
Edit section resource b C. NOM INVASIVE IMAGING

L I @ FORUM PHLEBOLDGY CD...HSO name/argument » D. SCLEROTHERAPY

== Add an activity or resource » E. COMPRESSION THERAPY
F. SURGICAL TREATMENTS
IN PHLEBOLOGY

» THERMAL ABLATION

- o | H. GLUE OBLITERATION IN
Edit settings \ > s

| =

L ANATOMY I Edit~ & VENOUS INSUFFICIEMCY

- Mowe right - Lo
& PRINCIPLES OF HAEMODINAMICS : e Lt oSG 2 L 2

: = Hide Edit™ 2 G4 » FORVENOUS STENOSIS OR
& Test lesson 1 ez Duplicate Edit™ 8 [F THROM
3 . 2. Assign roles J. TREATMENT OF VENOUS
&) TestLINK == - y o

» Delete ULCER

% @ TestBOOK Edit [F K. TREATMENT OF
>
[ 4 Add an activity or resource ] LYMPHOEDEMA

L. DRUG TREATMENTS IN
PHLEBOLOGY

TRAPP PROJECT | INTELLECTUAL OUTPUT 3 | Quick guide to using Moodle for teacher’s 15




Manage the sections in a course

Add an activity or resource

s nmomzmoomsome ] Add an activty o resource

ACTIVITIES
The chat activity module enables participants to have text-based, real-time
(@) ANATOMY Edit™ 3 [ O @ Assignment synchionous discussions
& Y?‘?} PRINCIPLES OF HAEMODINAMICS e @ o Chat The chat may be a ane-time actvity or it may be repeated at the same time each da.y
s it” 3 B4 or each week. Chat sessions are saved and can be made available for everyone to view
+ @ 1 O B choice of restricted to users with the capability to view chat session logs
() Testlesson1 Edit™ 8 [ 2
~ Chats are especially useful when the group chatting 1s not able to meet face-to-face,
¢ Database
* @ Testuink Bttt [ e suchas
® @ Test BOOK Bt [ O @ Exterai toai + Regular meetings of students participating in online courses to enable them to
= - e Feadback share experiences with others in the same course but in a different location
i eedbac)
+ Add clivity or resource * A student temporanty unable to attend in person chatting with ther teacher to
fo) 9 Forum catch up with work
* Students out on work experience getting together to discuss their experiences
el 0 Glossary with each other and their teacher
- 05' rmm 4 O @) Lesson * Younger children using chat at home in the evenings as a controlled (monitored)
> & "
ntroduction to the workd of social networki
# @) VENOUS INSUFFICIENCY B i o b
; -l- @ (o] e Ouiz * Aquestion and answer session with an invited speaker in a different location
L 2] {-'z’:_; VASCULAR ANOMALIES o — * Sessions to help students prepare for tests where the teacher, or other students,
= Edit™ § & O (@ ScoAM package ;
wauld pose sample questions
& 7] —
(’e LYMPHATIC PATHOLOGY Edit™ 8 & o ‘«?e Saicy e
= Add an activity or resource -
o @ wi
_ 2 @ i
RESOURCES
= (o} Eiook
P (&) oPPLER CW Edit™ 8 & o=
o] File
# @ coLor DUPLEX s 8 & )
o} Folder
@) COLOR DUPLEX POWERFOINT it ®
O () 1M content package
+ COLOR DUPLEX WORD : :
@ Edit ™ B

O @ Label
0 @ e Creating chat
0@ un

== Add an activity or resource
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Manage the sections in a course

Types of Activities

An activity is a general name for a group of features in a Moodle course. Usually an activity is something that a student will do that
interacts with other students and or the teacher.

In Moodle terminology, an Activity, such as Forums or Quizzes, properly means something students can contribute to directly, and is often
contrasted to a Resource such as a File or Page, which is presented by the teacher to them. However, the term activity is sometimes for
convenience also used to refer to both Activities and Resources as a group.

There are 14 different types of activities in the standard Moodle that can be found when the editing is turned on and the link 'Add an
activity or resource’ is clicked.

Assignments Enable teachers to grade and give comments on uploaded files and assignments created on and off line
Chat Allows participants to have a real-time synchronous discussion

Choice A teacher asks a question and specifies a choice of multiple responses

Database Enables participants to create, maintain and search a bank of record entrie

Feedback For creating and conducting surveys to collect feedback.

Forum Allows participants to have asynchronous discussions

Glossary Enables participants to create and maintain a list of definitions, like a dictionary

Lesson For delivering content in flexible ways

Allows participants to interact with LTI compliant learning resources and activities on other web sites. (These

(LTl External tool must first be set up by an administrator on the site before being available in individual courses.)

Allows the teacher to design and set quiz tests, which may be automatically marked and feedback and/or to

Quiz correct answers shown

SCORM Enables SCORM packages to be included as course content

Survey For gathering data from students to help teachers learn about their class and reflect on their own teaching
Wiki A collection of web pages that anyone can add to or edit

Workshop Enables peer assessment
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Manage the sections in a course

Types of Resources

A resource is an item that a teacher can use to support learning, such as a file or link. Moodle supports a range of resources
types which teachers can add to their courses. In edit mode, a teacher can add resources via the 'Add an activity or resource’
link. Resources appear as a single link with an icon in front of it that represents the type of resource.

Administrators can decide whether or not to force teachers to add descriptions for each resource by enabling or disabling a
site-wide setting in Administration > Plugins > Activity modules > Common settings.

Book Multi-page resources with a book-like format. 7eachers can export their Books as IMS CP (admin must
allow teacher role to export IMS)

File A picture, a pdf document, a spreadsheet, a sound file, a video file

Folder For helping organize files and one folder may contain other folders

IMS content package Add static material from other sources in the standard IMS content package format

Label Can be a few displayed words or an image used to separate resources and activities in a topic
section, or can be a lengthy description or instructions

Page The student sees a single, scrollable screen that a teacher creates with the robust HTML editor
URL You can send the student to any place they can reach on their web browser, for example Wikipedia
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Manage the sections in a course

Sections and Activities / Conditional Resources

It is possible to introduce Sections, Activities or Resources, in a conditional manner: on the basis of specific conditions, which
may also concern the students themselves, these contents can be shown or not to the students of the course. This
characteristic is generally defined as Conditional Activities.

The conditions that may be introduced concern, for example:
— evaluations, entered through the platform itself, totalized by the student during the quizzes, the tasks or other activities
proposed;
— time limits of material availability;
— restrictions on the profile of users and their personal data.

~ Restrict access

Access restrictions giudent  must  [v|  match | all [v] of the fellowing

@ Activity completion | Choose (] | mustbe marked comple[v] X

and

@ Date | from[v] || 18] January [v] | 2000[v] oo[v]|. so[w] s

 and ]
o &
O mustbez %

@ [0 mustbe< *» x [EE=E3 Require students to complete (or not

Activity completion complete) another activity
[ and |
@ Userprofilefield  choose ]| isequatie V] X

Prevent access until (or from) a specified
date and time

Require students to achieve a specified
- e -
Add resfriction.

Control access based on fields within the

User profile ;
student's profile

Add a get of nested restrictions to apply
Resiriction set complex logic
o
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Manage the sections in a course

Add an activity or resource: folders and files

Add an activity or resource

External tool o
The file module enables a teacher to provide a file as a course
Feedback resource. Where possible, the file will be displayed within the
) download it. The file may include supporting files, for example
an HTML page may have embedded images or Flash objects
Glossary
L 3 ANATOMY Edit 2 [ Mote that students need to have the appropriate software on
Lesson their computers in order to open the file.
+ PRINCIPLES OF HAEMODINAMICS Edit™ & [
| Quiz A file may be used
+ Testlesson 1 -
Edit” 8 4 + To shate presentations given in class
- - SCORM package
& Test LiNK Edit” [ + To include a mini website as a course resource
O N . f 3
- @ TeETE o O (M survey To provide draft files of certain software programs (eg
Photoshop _psd) so students can edit and submit them for
Add ag activit O
-+ f1 Activity or resource e Wik assessment
O @ Workshop () More help
RESOURCES
- VENOUS INSUFFICIENCY Edit™ 8 & O @ Book
L VASCULAR ANOMALIES Edit™ & [ @ @ File
+ LYMPHATIC PATHOLOGY -
Edit” 2 [4 @ Folder

+

Files on the server - =
" "3 Th Recentfiles |Ch0036tb€ﬁ|€ |

+ T e e from your PC
DOPPLER CW 71;

E%j?ﬁth%ﬁle & Uploadafie url of the file

v COLORBUPLEX (from cloud}m" Attachment Sfoglia..
AN~ B URL downloader
+* € COLOR DUPLEX POWERPOINT -
Insert from personal files ) .
% 9 COLOR DUPLEX WORD ‘ al | T P Private files Save as
|_ Insert content frorm \w'la'medial—i’-) P Wikimedia Author | Docente Test
' ) M Cloud TRAPP-Project
|. Cloud repository, | [ Choose license | All rights reserved

. . . Methods to load

[Code example for inserting video from the cloud]—‘ aresource Upload this file
<div id="imgframe">

<video tabindex="0" controls="" preload="none"

style="max-width: 1024px; max-height: 1024px"><source src="http://212.39.9.30/index.php/s/q7CzWRFIG3PYgcr/download" type="video/mp4" /></video>
</div>
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Manage the sections in a course

Add an activity or resource: Evaluation activities

ASSIGNEMENT

The assignment activity provides a space into which students can submit work for teachers to grade and give feedback on. This saves on paper and
is more efficient than email. It can also be used to remind students of 'real-world' assignments they need to complete offline, such as art work, and
thus not require any digital content.

Student submissions are together on one screen of your course. You can require them to submit one or several files and/or to type text essays. It is
possible to have them submit work as a group and you can also choose as a teacher to grade their work 'blind" in other words not to see the
identities of those who have submitted assignments. Assignments can have deadlines and cut off dates - which you can also extend if necessary

QUIZ

The Quiz activity module allows the teacher to design and build quizzes consisting of a large variety of Question types, including multiple choice,
true-false, short answer and drag and drop images and text. These questions are kept in the Question bank and can be re-used in different quizzes.
[Quiz quick guide|

WORKSHOP

Workshop is a powerful peer (and self) assessment activity. Students submit their own work and then receive a number of submissions from other

students which they must assess according to the teacher's specifications.
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Manage the sections in a course

Add an activity or resource: Activities for data collection

FEEDBACK

The Feedback activity allows you to create and conduct surveys to collect feedback. Unlike the Survey tool it allows you to write your own
questions, rather than choose from a list of pre-written questions and unlike the Quiz tool, you can create non-graded questions. The Feedback
activity is ideal for course or teacher evaluations.

SURVEY

The Survey module is a course activity that provides a number of verified survey instruments, including COLLES (Constructivist On-Line Learning
Environment Survey) and ATTLS (Attitudes to Thinking and Learning Survey), which have been found useful in assessing and stimulating learning in
online environments. Teachers can use these to gather data from their students that will help them learn about their class and reflect on their own

teaching.

CHOICE

The Choice activity allows you to ask a question and set up radio buttons which learners can click to make a selection from a number of possible
responses. They can choose one or more option and they can update their selection if you allow them. Choices can be useful as quick poll to

stimulate thinking about a topic; to allow the class to vote on a direction for the course, or to gauge progress.
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QUESTION BANK

This feature allows a teacher to create, preview, and edit questions in a database of question categories.

& Administration =

B My courses > PHLEBOLOGY COURSE »> Question bank > Questions

Question bank —

Select a category:

Default per PHLEBOLOGY COURSE :]

La categoria default per le domande condivise nel contesto 'PHLEBOLOGY COURSE'

No tag filters applied
Filter by tags v

] Show question text in the question list
Search options
[ Also show questions from subcategories
[J Also show old questions

Create a new question .. g

Choose a question type to add

QUESTIONS
I 1= Multiple choice
== True/False
O i Matching
O &3 Short answer
O & Numerical
O [ Essay
O 7 Calculated
) ¥ Calculated multichoice
O 3 Calculated simple
O 4+ Drag and drop into text
O 4 Drag and drop markers
© < Dragand drop onto image
O =% Embedded answers (Cloze)
O % Random short-answer matching
O w Select missing words
OTHER

O B Description

Select a question type 1o see its description

Cancel

w Course administration
& Edit settings
# Tum editing on
¥ Course completion
b Users
T Filters
» Reports
£ Gradebook setup
& Outcomes
b Badges
ot Backup
& Restore
& Import
© Reset
Question bank
@? * Questions

"= Categories

® Import
® Export

£ Repositories

The possibility of subdividing

the questions into categories
facilitates the construction of
the quizzes

The categories can be
limited to being used on
the site, course or quiz
level. The questions in a
category can be added
to a Quiz or to a lesson
activity via an export
process. The teacher
enters the question bank
by creating or editing a
quiz activity or via Course
administration > Question
bank
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Course Users Management

List of partecipants

@ Dashboard B Events B My Courses E= Hide blocks x¢ Standard view|
People
B & Peop List participants participants
= > My courses > PHLEBOLOGY COURSE > Participants ET Grades in the course
@ Forums
Participants @ Lessons <% Navigation
Mo filters applied @ Resources
Search keyw
A # Site home
Number of participants: 15 » Site pages
Firstname M » 5'c' b F F o ~ My courses
Surname B - 2 co e/ F s TuwvwXy z X ~ PHLEBOLOGY COURSE
Select First name “* f Surname Email address Country Roles Groups Last access to course Status l— — -
Participants
= = = = = = = =
® Course blogs
(] Alessandro Frullini dr.afrullini@gmail.com Italy Teacher MNo groups 32 days 23 hours £ M -
Notes
O Q Augusto Sampaio europhlebologists@gmail co I Edit Alessandra Frullini's enraiment 2 XK ® Docente Test
. g Enrolment method Manual enrolments ¥ Badges
(] Daniela Radu flebologie@yahoo.com £ X
A .
Staws | Active & Competencies
O Docente Test rossella@prai.it = X ER Grades
Enrolment starts | 18[~] || December 2018[>] | 15[+ || 4[] |y B Enable
(] Francesco Vallebona vallebona@medineurope.cory £ X © ]
Enrolment ends | 22[] || January 2019~ || 10f~]|[ 8[| CIEnable P A.BASIC PHLEBOLOGICAL SCIENCE
Pavei Patrizia atrizia pavei@gmail com
- P pavei@g Enrolment created Tuesday, 18 December 2018, 345 FM halke » B.VENOUS PATHOLOGY
O Polizois Zois hellenicsds@gmail.com N £ X b C.NON INVASIVE IMAGING
# D. SCLEROTHERAFPY
O roveropisacer  rbisaceigyahosit [oovechree [ -
» E. COMPRESSION THERAPY
(] Studente Test tecnico@econet.it Italy Student Mo groups 7 days 20 hours 5 X
©f Administration
Send a message to Srrelusers X T X *
Register participants in
Enrolment options
P the course * Course administration
Select all Deselect all @ . . -
Select users No selection £ Edit settings
With selected users... Search ¥ i Rosella Alunni prait rapp@gmail com # Turn editing on
Send a message Select cohorts Mo selection Account Jolly econet@econet it e £ course completion

Add a new note Search A Studente Test wecnico@econet it > - Users
Manual enrclments

2. Enrolled users

Edit selected user enrolments

Delete selected user enrolments
Self enrolment

Edit selected user enrolments (

Delete selected user enrolments 2 Groups

Enrol selected users and co Cancel » Permissions

Assignrole | Student

» Enrolment methods
Show more...

2. Other users
Y Filters

» Reports
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Course Users Management

Enrolment methods: Manual enrolments

= » Mycourses > PHLEBOLOGY COURSE » Users > Enrolment methods

Enrolment methods /
Name Users Up/Down Edit
4{ W}—) Manual enrolments 14 + L@
Guest access 0 LK Y X & o

dd method [ETTT

m ‘_) e o
‘code 2

Self enrolment

Cohort sync

=

—* Manual enrolments

Enrolled users Not enrolled users

Enrolled users (14)
Roberto Bisacci (rbisacci@yahoo.it, IT)
Alessandro Frulling (dr.afrullini@gmail.com, IT)

Not enrolled users (4)
Rosella Alunni (prait.trapp@gmail.com, IT)
Account Jolly (econet@econet.it, IT)

Giuseppe Genovese (europeanregisterphlebologists@gmail com, IT) Assign role Studente Test (tecnico@econet.it, IT)
Paclo Giardini (paclo@econet.it, IT) Administrator WebMaster (rosella@econet.it, IT)
Paslo Giordano (pgiordans@healthchamber.eu, ) Student [~

Olivier La Rocca (o larocca@europartnersnetwork. eu, IT)
Giovanni Mano (giovanni nans@unimiit, IT) : . K .

Pavei Patrizia (patrizia.pavei@gmail.com, IT) e ) dU_I'EIIOI'I (-[quﬁrwj
Daniela Radu (flebologie@yahoo.com, RG) Unli nﬁtedl]

Augusto Sampaio (europhlebologists@gmail. com, PT)
Docente Test (rossella@prai.it, IT)

Francesco Vallebona (vallebona@medineurope. com, BE) Starting from [

Marco Viani (vianimarcomd@libero.it, IT) Now (22/01/19,13:33) E
Polizois Zois (hellenicsds@amail com, GR)

Starting date of
of the registration

4

Search oot Search

Remove user selected
from the course

Search options »

& Administration

w Course administration
£* Edit settings
# Tum editing on
£ Course completion
w Users

2. Enrolled users

Enrolment methods
® Self enrolment (Student)

2 Groups
» Permissions
2. Other users
Y Filters
» Reports
¥ Gradebook setup
& Outcomes
» Badges
%) Backup
% Restore
& Import
= Reset
» Question bank

= Repositories
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Course Users Management

Enrolment methods: Self enrolments

= > Mycourses > PHLEBOLOGY COURSE > Users » Enrolment methods

Enrolment methods ]
Name Users  Up/Down Edit

r Self enrolment (Student) 1 + X @

~ Self enrolment

o

Disabling the setting, all
spontaneous registrations
be suspended

Custom instance name

Allow existing enrolments (7)

Yes

Dizabling the setting, new
Allow new enrolments (7) Yes reg'ﬁtraﬁoga mnzﬁ)e pqamhh

Enrolment key (7 Click to enter text »° Q)

\"mm_twm
Use group enrolmentkeys (@ No [v]| enroliment in the course.

By leaving the field empty, any
Default assigned role | Student authenticated user can
fegjster
Enrolment duration (2 0 days [ Enable < Duration of reg'ﬁtra}ioo in days (0=
; - no limit).
Notify before enrolment expires (7] No To chamen@bth@onuoo first.
Notification threshold () | 1 days I
Startdate (@ | 22[+] || January 2019~ || 14[7] || 04[] |py  CIEnable Course notification settings to send.
to subscribers
Enddate (3 | 22[V]| January 2019[v]|| 14[v] || 04[v]| @ CEnatle
Unenrol inactive after () Newver

Max enrolled users (2 | 0
Only cohort members (7 | No
Send course welcome message (1)

From the course contact

Custom welcome message (7)

£ Administration

+ Course administration
¥ Edit settings
# Turn editing on
#* Course completion
w Users
2. Envolled users
~+ Enrolment methods
%@ = Self enrolment (Student)
& Groups
» Permissions
2. Other users
Y Filters
» Reports
#F Gradebook setup
& Outcomes
» Badges
s Backup
it Restore
s Import
) Resel
» Question bank

£ Repositories
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Course Users Management

Tracking progress of a student

There are several ways to track student progress in Moodle. This page outlines what is available to teachers in a
course.

Contents

1 Grades

2 Competencies

3 Activity completion
4 Course completion
5 Badges

6 Course reports

7 Analytics

Grades
Every course has its own Gradebook which is accessible from Course administration > Grades. Some activities such

as Assignment and Quiz send grades back to this gradebook. It is also possible for teachers to enter grades directly
into the gradebook.

Competencies

Competencies describe the level of understanding or proficiency of a learner in certain subject-related skills.
Competency-based education (CBE), also known as Competency-based learning or Skills-based learning, refers to
systems of assessment and grading where students demonstrate these competencies
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Course Users Management

Tracking progress of a student

Activity completion

If Activity completion is enabled by the administrator in the course settings, teachers can indicate for each course
item how they wish it to be registered as complete. A tick/checkmark will then appear against the activity. Students
may either mark it complete manually or the item will automatically be registered as complete once a student has
met the specified criteria. These may be viewing a resource, submitting an assignment, posting in a forum or other
conditions. The teacher can see an overview of who has completed what in the activity completion report in Course
administration > Reports > Activity completion.

Teacher view

. § -D
Student view g g
2 |2
R 3
W Announcerments from your taor Lo 2 g
> o = 7] m
& Prior Knowledge assessment e % a 5
m
. i w o (e
| Faciusl recal tast = B3 2
oo O e o & w
Y&y Course chat x 5 El 2 =S
g |3 - 0
§ % & =&
g e @
First name | Surame b = v =
Frances Banks F & & O
Mark Ellis 8 &8 ¥ O
Brian Franklin 0O & & 0O
Barbara Gardner M & & 0O
Amanda Hamilton F & & 0O
Joshua Knight .M &4 & 0O
George Lopez F 8 & O
Anthony Ramirez F & & O
Donna Taylor 0O 88 ® O
Brenda Vasguez M & & O

TRAPP PROJECT | INTELLECTUAL OUTPUT 3 | Quick guide to using Moodle for teacher’s 28



https://docs.moodle.org/34/en/Activity_completion
https://docs.moodle.org/34/en/File:studentviewactivitycompletion.png
https://docs.moodle.org/34/en/File:activitycompletionreport.png

Course Users Management

Tracking progress of a student

Course completion

As an extension of activity completion, enabling Course completion allows for a course to be officially marked as
finished, either manually or automatically according to speficied criteria. If the Course completion status block is
added, students can see their progress during the course. Teachers can view the overall progress of students
towards course completion from Course administration>Reports>Course completion.

Student view Teacher view

COURSE COMPLETION STATUS BEE
Status: in progress i i
- HHTIREE AN
All criiena below are required H { - I‘ii H
LR
Required criteria status cracs RERE R
Vot B 2 (R0 W & 2|0
|
Activity completion Sof8 P @lm|g|ojo|=iojo|o
Mart Bt B2 e 2|2 0o|o|o
R — olr|e|ooe|a|o|o
More details Barhara Garener 2222|0200l
Amanda Hamikan H M EHEEREMER|E
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Course Users Management

Tracking progress of a student

Badges

Badges can be awarded either manually or using activity completion settings in a course and are a popular way to
motivate students. Students may be awarded badges at different stages of the course for different levels of
progress.

Course reports

A number of Course reports are available to the teacher in their course to help them track the progress of their
students. In addition to the activity and course completion reports mentioned above (which are only available if
these settings are enabled) there are also activity reports, participation reports and general course logs.

Analytics

The Analytics feature, in Moodle 3.4 onwards, provides detailed descriptive and prescriptive reports to support
learners at risk.
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Insights

Upload large files

Currently, in the portal https://learning.europeanregisterphlebologists.eu, it is not possible to upload files with dimensions
exceeding 16Mb, to overcome this limit a cloud repository has been activated in which it is possible to upload large files (even
1 Gb).

Once uploaded, they can be recalled via links within the course.

Below are the credentials and information needed to upload the files

(Access credentials will be communicated via e-mail.)
After logging in, the folders and files present are displayed. Please create a folder with your last name in which to insert your
files. The folder can be created by clicking on the + icon at the top and then on "Folder".

Files can be uploaded by clicking on the + icon at
the top and then clicking on “Upload”

Each file uploaded to be "called” within the course
must be shared.

To create the share click on the share icon (3

connected dots), then in the right column select

"Sharing” -> "Public Links" and then on "Create
B oo public link".

A window will open, check that "Read Only" is
selected and then click on "Save" and leave the
other input fields unchanged
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Insights

Upload large files

To copy the link you just created, click on the "Copy to clipboard" icon (block with arrow on the left)

2 % A A * B

Tutti | file

Preferit

Condivisi pon te

Condivisi oon altr

Condivisi tramite collegamanic

Tag

1 Frullini 4

Home =

Q FILEminimizerPhctures-Free-Sati. 4 Condiviso F!;E-"ﬁ nimizerPiciures-Free-Setup ane
% 4.7 MB. 7 ghorni fa

Etichatie collabarative

Commenti Condivisione “Versioni

x

Create link share; FFrullinif/FILEminimizerPictures-Free-Setup.exe B Erappl

Collegament] pubblic]

Link Marmg e =
: ErminimizerPictures-
ElLEminirnizerPlotures-Free-3aiup gxe collegamenta (2) e-Setup.exe BO<W
legamento
® Read only
Wsers can view and dowmload contents. oliegamento pubblico

" with the link has access to the

ler

Scadenza

Annulla
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Insights

Upload Iarge files: how to insert the newly created link in a lesson or web page.

[= > My courses > PHLEBOLOGY COURSE > A. BASIC PHLEBOLOGICAL SCIENCE > Testlesson1 > Edit > Expanded > Edit

Test lesson 1 ®

Preview

Import questions | Add a content page | Add a cluster | Add a question page here

Download test

HTML source code

Reports Grade essays

TEST PAgina con contenuti %, £ 4 O X

<h3=Download <a
href="http://212.39 9. 30/index php/s/qTCz2WRFOG3PYger/download”
target="_blank"stest </a=</h3=

Il passaggio standard del Lorem Ipsum, utili sin dal sedicesimo sgcolo
~Lorpea I . dimimainm alil and de o i bk s Lt s sdajore magni aliqua. Ut
enil Test lesson 1 @ Duis autp irure dolor in
repr} jt non projdent, sunt in [
culpy .

- Editing a content page — =
La |da Cigcerone ~ sciEnce

Page tithe - ®
nej TEST PAgina con contenutl Ll AR L

@ PRINCIPLES OF
"Seq i rem aperiam, eague
Ny voluptatem quia HAEMODIMAMICS
voi sequi negciunt. Neque Test besson 1
por pm eius modi tempora
inci italionem ullam L © Test LINK
COrgy poerit qui inea voluptate @ Test BOOK
welit W
Tr Insertedit link Em °c
1 i MAGING
Il passaggio standard del Lorem Ipsum, ul] — - - .
‘Buf  dal sedicesimo secolo - General properties I
onf

:Bp *LOrem IDsuUm COIOr ST Amet, CONBECTetur AEDISCING 65, 36d GO Susmod e || pm= Link URL [hitp://212.39.9.30/index. phy's/ip1 VTUBUSS4FYHAZ [TT]

Paan h3 = s G
purg Target  (Goen i new vindom (_bian) 1/~ toopen thelinkin a new window
desl 59 arange content buttons horizontalty? e | ]
him - )
adv & Dusplay in menu® Cass |- Mot set - =] N
cor

} ; - (Rasia e naly, crealadiQUBIG bk 0. 196 clakids

A Sires Wk i Spr i st & Coeerla sl posts & Lieoes b et (50T WEY

For a direct download, add at the bottom of the link /download
hitp://212.39.9.30/index.php/s/q7 C2WRFIG3PYgcr/download

PRI 36 5 30 T0e TND S TR G IS  CONIoNs

VENOUS
direct link

Salvare FILEminimizerPictures-Free-Setup.exe (4,73 MB) da 212.39.9.307 Salva |"' l | Annulla >
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Insights
Embed a Video

When you embed a video in Moodle, it is still stored on the video hosting site (e.g. on YouTube or theBox), but you can view
it directly in Moodle.

Including video elements in your course can bring life and movement to an otherwise static page, and increase student
engagement. Videos can be lectures, interviews with experts, demonstrations, animated explanations of concepts etc.

This is the most straightforward method of inserting a YouTube video in a course, but you cannot resize the video
once it is uploaded.

1. Locate the relevant video on the YouTube

O hf . .
= Open URL | website, and copy its URL.
Youli)™ Search " Look Up “https://www.youtube.com/..”
| Search with Google

o Cut
Pas;te

Font family -  Font size w Paragraph

B I U & X ¥

[2)
v

Video Insertfedit link

2. In the text editor of the page where you want to embed the video, highlight
the link text and click the link icon.

r

I
il
2
|
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Insights

Embed a Video
— 3. In the /nsert/edit link window, paste the URL into the Link URL field and click
G‘;’::'ra-l|p:‘;‘::::”ﬂsE"e"“ I Advanced | Insert. The text will display in the text editor as link text. Click Save Changes.
Link URL || ,_IEI
Target |: I $
g Paste |
dass [ Spelling and Grammar 8
= Substitutions |
o Transformations »
Font »
Speech >
Paragraph Direction »

~ Section 3 ~

Sin Cos Tan - Basic Trigonometry-... @ &

| Label sides / 5
Werk sd +rig fonchen .
WJ\JH UIIWS x

& Solee

4. The video will be displayed in the chosen location.
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Insights

Embed a Video

Embed a YouTube video (flexible method)

Teachers or students can use the following method:

Share.

¢ 1. Go to the YouTube page for the relevant video. At the bottom-right of the video frame, click
-+
W

Share

fl¥]c 8K t o] «]in]n ]S

ttps://youtu.be/E9_d_ET9yjl
D Start at

EMEED CoPY
B

oot -l-.ris Ma; .
ihle yalues o<

Embed Video

e iframe width="560" height="315"
src="https:/fwww youtube comfembed/ES_d_ET%yjl

" framehorder="0" allowfullscreen></iframe=>

D Start at

EMBED OPTIONS
Show suggested videos when the video finishes.
Show player controls

Show video title and player actions.

Sin.Cos Tan - Basic Trigonometry - Wor... o ~»

COPY

2.0ptions for sharing will display. Click Embed. A popup box appears with some options
below it.

3. If the standard embed size of 560 x 315 pixels is suitable for your course
purposes then go to step 4 below. Otherwise, you can change the video size by
entering your preferred width and height in the code as shown below. You can also
change several settings such as the starting time under Embed options.
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Insights

Embed a Video

4. Select all the code in the Embed Video box and Copy it.

Sin Cos Tan - Basic Trigonometry - Wor... @8 =

oot +rig fonchon .
bl yalues K

€

Embed Video

<iframe width="560" height="315"

.................

[] startat Lk

Cut
pash

Select All
Show player cont

Show video titley  Print..
|:| Enable privacy-er

Inspect

Speech
Services

05“:‘https:Hv.ww.ywmbe.comfembediES‘_d_ET‘)yjI
/ e somipmbiFD d 1 ]
" frameborder="0" allgy  Look Up “<iframe width="560" height<

FMPEDOPTIONS e

Show suggested  Paste and Match Style
Search Google for “<iframe width="56(

Language Settings
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Insights

Embed a Video

5. in Moodle, in the text editor, click the Edit HTML Source icon.
E Font family + | Font size v | Paragraph = ﬂ 0n 3:
@.-'U%E#EEE@'RF‘U%h,vg..;vrﬂ‘m
== = Q&@Eﬁiiii%cnﬁnﬁiﬁza
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6. In the HTML Source Editor, click where you want the video to display, and Paste in the embed code.

HTML source editor

HTML source editor

Spelling and Grammar »

7. Click Update and then Click Save.
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Embed a Video
Resize an embedded YouTube video

You can resize a YouTube video that you have embedded in a Moodle course by following these instructions:

1. In the text editor, click the Edit HTML Source icon

2. In the HTML Source Editor window, locate the HTML tags for width and height. The numbers accompanying these tags
indicate the current pixel width and height of the video. Change these numbers to suit the size you want, being careful to

maintain the aspect ratio so that the video does not become distorted.

HTML source editor
HTML source editor
<pr<iframe width="560" height="315" sre="https:/ www.youtubd
frameborder="0" allaowfullscreen=""></i1frame></p>

12/

3. Click Update.
4. Check that your video displays at the correct size.
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